Final Cut Pro X: Basics and Recommended Practices
(rev. 9/11/12)

Important Terminology Changes

Project (FCP 7) = Event (FCP X)
Sequence (FCP 7) = Project (FCP X)
Track (FCP 7) = Storyline (FCP X)
Scratch Disks (FCP 7) = Event Library (FCP X)

Bin (FCP 7) = Smart Collection (FCP X)
Marked Clip (FCP 7) = Selection (FCP X)
Ingesting/Capturing (FCP 7) = Importing (FCP X)

Media Management Basics

In terms of media and file management, Final Cut Pro X is quite different from past iterations of Final Cut Pro. Before we go over managing media from within FCP X, let's look at how FCP X relates to the Finder.

You can store your media files in any location on any drive in or connected to your computer, but FCP X stores all other essential files (project files, render files, analysis files, etc.) in two discrete folders: Final Cut Events and Final Cut Projects.

When you first launch FCP X it automatically creates a Final Cut Events folder in the Movies folder of your home directory. When you create a new Project its default location is also the Movies folder.

However, for optimal performance, you can (and should) store your FCP X Events, Projects and media on a non-system hard drive—either another internal drive or an external drive connected via eSATA, Firewire 800, Thunderbolt or USB 3.0. To move your Events and Projects from your Movies folder to an additional internal or external drive, simply drag and drop these folders in the top or root level of the additional drive.

*USB 2.0 drives are not supported.*

The Events and Projects folders must be at the top level of any non-system drive, not in sub-folders, otherwise FCP X will not see them.
Inside the Events folder are folders for each of your events, and in each of those folders is an Original Media folder. Depending on how you import your media into FCP X (more on this on page 3), the Original Media folder will contain either alias files to the media or the media files themselves.

Recommended Peripherals for Maximum Performance

Final Cut Pro X is a 64-bit powerhouse, and editing standard definition projects in almost any configuration (editing from an internal drive or external Firewire drive) should be a breeze. If editing HD material however, you would be wise to configure your system to take full advantage of the software’s processing capabilities. For one thing, you should make sure that your computer has the maximum amount of RAM installed. Other World Computing is a good place to go to find out how much RAM your computer can hold and to purchase the RAM.

As mentioned above, you can store your projects, events and media in folders that FCP X creates in the Movies folder of your home directory. However, to spare your processor the burden of running the OS and FCP X and reading and writing media files, you should work off of an additional drive whenever possible—especially if using a laptop.

New Macbook Pros include Thunderbolt ports—Thunderbolt is up to 12 times faster than Firewire 800, but we can’t speak to its performance and speed from experience as we haven’t had a chance to test it yet. Thunderbolt drives are quite a bit more expensive than Firewire drives but their prices seem to be steadily decreasing.

Getting Started - Working With Events

For maximum performance, quit all other programs while using Final Cut Pro X. Connect the drive you’ll be using to store your events, projects and media and launch FCP X.

The first time you launch FCP X the program will create a New Event in the Movies folder of your home directory. Before we get into the details of how to configure and move the Event, let’s take a moment to discuss what an Event is...

As noted on page 1, an Event in FCP X is roughly equivalent to a Project in FCP 7—it’s a collection of media. Any time you import media, you must import it into a particular Event. Your Event Library contains all of the FCP X Events and imported media in your Movies folder and on any connected drives.
Working With Events (cont.)

To demonstrate some basics of managing Events, let’s rename our default event, move it to an external drive, and delete the original copy.

Click in the Event’s title field to rename it.

To copy your Event to an external drive simply drag and drop its icon on the icon for the drive.

To prevent redundancy, delete the Event from the internal hard drive. Right-click or control-click on the original event then select Move Event to Trash.

Importing Media

Use the shift-command-I keyboard shortcut, the File menu or the Import Files button in the clip window to import media into your event (or into a new event).

FCP X gives you the option to copy your media files to your Events folder. In the example given here, we’re importing media from the internal drive to an Event stored on an external drive. To keep all media and other FCP files in the same location, we’ll select that option.

FCP X allows you to use three types of media: native, optimized and proxy.

Native is the original format the media was encoded in. For example, your native format is H.264 if shot on a Canon 7D and XDCAM EX if shot on a Sony EX-3. Those two formats and native formats used by most other cameras can be difficult to edit with— in general we don’t recommend using native media.*

Optimized media means Apple ProRes 422. ProRes 422 offers superior image quality and high performance—it’s been our recommended editing format for several years. However, with HD material and complex, effects-laden projects, using full-resolution ProRes 422 media can result in performance problems, especially when working on a laptop.

Proxy media means Apple ProRes 422 Proxy. This format offers high image quality at 1/4 of the size of standard ProRes 422, allowing for a smoother editing experience without a significant loss in image quality.

*One scenario in which native mode would be appropriate is a project involving green screen compositing—you’d import Apple ProRes 4444, but for maximum editing performance you’d still use proxy media.
Importing Media (cont.)

To import to ProRes 422 from a Canon 7D or Canon 60D, make sure you've installed the Canon XF Plugin for FCP X, then use the USB card reader in the camera's kit and the Import From Camera command (command-I). Importing as ProRes from an EX3 is more complicated and is detailed in another PDF*.

After you've clicked the Import button you might see a big red media offline icon in the Clip Window. Don't worry—as soon as the optimized and proxy versions are done transcoding, your media will appear.

If you look in your Final Cut Events folder in the Finder, you'll see that there are now two new sub-folders containing the High Quality and Proxy versions of your media.

Working With Projects

As mentioned before, a project in FCP X is roughly analogous to a sequence in past versions of FCP.

Select “New Project” from the File menu or just click the “Create New Project” button. As you can see here, you must designate a Default Event for your project—in this case we've only created one event so it's our only option.

If you click OK, your project’s Video Properties will be based on the first video clip you drag into the timeline. This is a useful default, but we're going to click “Use Custom Settings” to look closer at the available options.

You can set your project to a particular format here—this won't re-encode your media, it will just render it accordingly in this project only. For example, if you know you want your final output to be 1080p30, but the first video clip you plan to edit is NTSC DV (720x480) you would use the custom settings shown here.

Click OK—FCP will automatically open your new project. You can start dragging media into it immediately.

To access the list of projects in the Project Library use Command-0 or click the film reel icon at the bottom left corner of the screen.

Control-click on any project in the Project Library window to access a list of commands such as Consolidate Project Media (which allows you to copy or move a Project and its related Event) and Move Project to Trash and to do things like create folders and play your project full screen.
Working With Projects (cont.)

FCP X does not have a Save command, it saves automatically, and you can allegedly backtrack limitlessly using the Undo command. However, if you are the sort of editor who saves multiple versions of the same sequence, or if you tend to save a new version of your FCP 7 project every time you make major revisions, you should use the Duplicate Command function anytime you get the itch to (in FCP 7 terms) “Save As.” We would strongly urge you to FREQUENTLY use this command—FCP X and its autosave features are robust but not flawless—the only surefire way to access past revisions of a project is by duplicating it, or via compound clips (more on that at http://www.larryjordan.biz/fcpx-compound-clip/)

To duplicate a project, go to your Project Library and use the Command-D keyboard shortcut OR control-click on the project to select the command from its pop-up menu.

You can duplicate your project on the same hard drive or you can duplicate it on a different drive. If duplicating to a different drive (e.g. to archive the project or give it to a co-editor), choose the 2nd or 3rd options so that the media associated with the project also gets copied.

Optimizing Performance

To utilize the performance boost offered by proxy media, go to File > Preferences, click the Playback tab and select “Use proxy media.” If at any point you wish to see your higher-res optimized media (e.g. if you are displaying it full-screen) simply switch to “Use original or optimized media.”

Another way to boost performance is by changing the way clips appear in the timeline. Double-click on your project to open it. The Clip Appearance controls can be accessed via the button underneath your timeline and to the right of the Timeline Zoom slider. Select the last option. This will display your clips without thumbnail images or audio waveforms—generating and refreshing thumbnails and waveforms can slow FCP X performance.

Another way to improve performance is to limit the number of events and projects you have open. You might consider using the Finder to move projects and events you’re not using to a folder called something like “FCP X Not In Use.”
Editing Basics

Before and at any point during editing, you can organize your footage in the Event Browser. Skim through clips in the Event Browser by dragging your mouse across them and assign in and out points using the I and O keys and by adjusting the "handles" on your selections.

Click on any of the columns in the browser to sort by that parameter. Drag and drop the columns to rearrange them. Control-click or right-click on any of the columns in the browser to bring up a drop-down menu with further sorting options.

Use the favorite, unrated, reject and keyword buttons to organize your clips—you can favorite/reject and add keywords to entire clips or sections of clips.

Preview a project’s contents in the Project Library window by skimming across its "filmstrip."

Quickly create new projects or folders by selecting the drive where they should be located and clicking these buttons.

To edit a particular project, double-click on its icon or filmstrip in the Project Library window—this will open its timeline.

In FCP X is the concept of tracks has been replaced by that of storylines.

The dark strip in the middle of the timeline is the primary storyline. You can think of it as V1/A1/A2, all in one row, but storylines behave quite differently from tracks*. You can attach clips to particular frames of clips in the primary storyline, and they become connected clips. If you move a clip in the primary storyline, any clips connected to it move as well.

Steve Martin at Kenstone.net offers the following analogy:

*The track paradigm is much more akin to traveling along a multilane U.S highway. You can only drive so fast; you must stay in your own lane until it's safe to change lanes, and you must always be mindful of where other vehicles are to avoid collisions. FCP's new Storyline paradigm on the other hand, is much more like traveling along a single lane highway of the future where the traffic auto flows around your car and the lane itself prevents collisions with other cars.*
In FCP X there are numerous ways to perform the same action: buttons, keyboard shortcuts, dragging and dropping, via pop-up menus, etc. FCP X has kept the great majority of keyboard shortcuts from FCP 7 (including JKL scrubbing) and has added numerous new shortcuts for new functions. A complete list of FCP X keyboard shortcuts can be found at http://www.premiumbeat.com/blog/the-big-cheat-sheet-of-final-cut-pro-x-shortcuts/

FCP X allows several ways to add a clip to a timeline. The three most basic edit types are appending, inserting and connecting.

To perform an append edit, select a clip in the Event Browser, set in and out points if you haven’t already and press the E key or click the append edit button. The clip is added to the end of the storyline.

To perform an insert edit, select your clip in the Event Browser, then click the insert edit button or press the W key and the clip will be added at the position of the playhead or skimmer*. Any clips at the playhead/skimmer position will be split and/or shifted to the right (or downstream) to make room for the new clip.

*It’s important to note the difference between the skimmer and the playhead. Skimming is enabled or disabled via the S key or the buttons at the right side of the timeline. If skimming is enabled, a red line (the skimmer) will follow your mouse as you move through the timeline. Once you click at a particular frame, the playhead will merge with the skimmer. If you perform an edit using keyboard shortcuts the edit without clicking to move the playhead to the skimmer location, the edit will happen at the location of the skimmer, not at the playhead.

To perform a connect edit, press the Q key or click the connect edit button. This will connect the clip above whatever clip is in the timeline (see diagram on page 7) at the position of the playhead or skimmer. As with past versions of FCP, video clips obscure whatever clips are below them, so a connected clip will essentially replace whatever is below it—however, it will not delete what’s below it, it’s more or less composited above the storyline.

The two other edit types are overwrite edits and replace edits. An overwrite edit will add a selected clip to the primary storyline at the playhead or skimmer position—whatever is in the timeline at that position will be deleted for the duration of the new clip—the existing clips will not be shifted downstream. To perform an overwrite edit, go to the Edit menu and select Overwrite or press the D key.

Replace edits are a bit more complex and there are four ways to execute them: Replace, Replace from Start, Replace from End and Add to Audition (which is too complex for a FCP X Basics guide!). In a basic Replace edit, a target clip is completely replaced by a new source clip selected in the Event Browser—the clip sequence in the timeline will be shortened or lengthened (shifted upstream or downstream) accordingly. In a Replace from Start edit, the target clip is replaced starting with the first frame of the source clip. A Replace from End edit works the same way, but the last frame of the target clip is aligned with the last frame of the source clip and the footage is backticked to fill the target clip. In a Replace from Start or Replace from End edit, if the source clip is longer than the target clip, the resulting clip is not lengthened—it will match the duration of the target clip. However, if the source clip is shorter than the target clip, a warning will be displayed and the resulting clip will be shortened, shifting the sequence in the timeline upstream.

To perform a replace edit, set in and out points for a clip and drag the clip from the Event Browser (via the hand icon) to a target clip in the timeline. The target clip will turn white and you’ll see filmstrip and plus-sign icons. Drop the source clip on the target clip and a drop-down menu will appear.
One of the most dramatic changes in FCP X is the feature called the Magnetic Timeline. By default, the software prevents you from creating gaps and accidentally overwriting existing clips in the timeline—when you move a clip or a group of clips next to clips already in the timeline, your clips are automatically aligned to the edges of the other clips, or if you move clips over existing objects in the timeline, those objects will move out of the way to make room for the new clip. This feature can be extremely useful but it’s important to know how to bypass it if you want to overwrite objects in the timeline.

The default tool in FCP X’s tool palette is the Select tool (accessed via the A key). When this tool is in use, the timeline behaves as described above. To bypass this behavior and place clips in exact timeline locations without the other clips aligning or moving out of the way, use the Position tool (via the P key). When the Position tool is in use, a clip placed over another clip will overwrite that portion of the clip. If a clip is placed on a blank section of the timeline (e.g. after the end of a sequence), a gap (aka slug) will fill the space in between, as shown below.

As explained on page 7, the concept of tracks doesn’t really apply to FCP X—by default, a clip in the timeline contains video and audio all on in one unit. However, it’s very easy to separate audio from a video clip via two basic methods, Expand or Detach, accessed by right-clicking or control-clicking on the clip.

One advanced feature that deserves mention here is the Compound Clip (similar to “nested sequence”). Select a group of clips in the timeline, right-click or control-click, then choose New Compound Clip—this new clip will behave like any other clip. Double-click on it to edit it in its own timeline, then click the triangle at the upper left of the timeline window to return to the main project timeline.

Every clip in the timeline includes a tiny set of arrows in its upper left-hand corner. Clicking on those arrows opens a drop-down menu that can quickly lead you to more advanced editing options such as color correction, video and audio effects, animation via keyframing (opacity, scale and other motion effects, cropping, etc.) and other powerful features.
Exporting a Project

The Share menu in FCP X includes numerous new options for exporting a project directly to various video hosting sites, (YouTube, Vimeo, etc.), Apple devices and to Compressor, but we have not fully tested and assessed these options. Our recommended workflow remains to export an Apple ProRes 422 Quicktime “master” file of your project which can then be used by other programs to encode it in whatever format you require (Adobe Encore for Blu-rays, DVD Studio Pro for SD DVDs, etc.).

To export a ProRes Quicktime file of your project, select it in the Project Library (or simply open the project), then choose Export Media from the Share menu.

Click on Video codec to bring up a drop-down menu of format options including ProRes 422.

Click Next, then you will be asked to designate a location for the resulting file, then click Save. That’s it!

To dig deeper into the powers and intricacies of FCP X, here are a few resources:


FCP X video courses at Lynda.com (available to all SAIC students, faculty and staff): http://www.lynda.com/search?q=final+cut+pro+x&x=0&y=0

FCP X tips and other resources on editing via Larry Jordan: http://www.larryjordan.biz/category/articles/editing/

Free FCP X video tutorials: http://www.izzyvideo.com/final-cut-pro-x-tutorial/

Various FCP X tutorials, news and tips: http://www.premiumbeat.com/blog/category/final-cut-pro-x/

Extensive FCP X video primer by Evan Schectman of Outpost Digital, sponsored by Tekserve: http://www.youtube.com/watch?v=TwF9J1_gYzl&feature=related